
 

 
 

 

 

   

   

   

VVVeeerrrsssiiiooonnn   111999...000      

UUUpppdddaaattteee   DDDooocccuuummmeeennnttt   
 
 
 
 
 
 

© RFMS, Inc. 
3073 Palisades Court 
Tuscaloosa, AL 35405 

  
  



 

2 
 

Table of Contents 
 

SYSTEM-WIDE .............................................................8 

PO Integration ............................................................................................................................. 8 

Date Shortcuts ............................................................................................................................. 8 

Users ............................................................................................................................................ 8 

Reports......................................................................................................................................... 8 

Attachment .................................................................................................................................. 9 

Export to Order ............................................................................................................................ 9 

SYSTEM OPTIONS ........................................................9 

Browse Screen ............................................................................................................................. 9 

Copy System Options ................................................................................................................... 9 

ORDER ENTRY .............................................................10 

Notifications .............................................................................................................................. 10 

RFMS Smart Search Fields ......................................................................................................... 10 

Customer Orders, Quotes, and Claims ...................................................................................... 10 

Customer Orders ....................................................................................................................... 12 

Quotes ....................................................................................................................................... 18 

Claims ......................................................................................................................................... 19 

Batch Processing ........................................................................................................................ 20 

Customers .................................................................................................................................. 20 

Reports....................................................................................................................................... 26 

Utilities ....................................................................................................................................... 28 

PRODUCTS ..................................................................29 

General ...................................................................................................................................... 29 

Roll Products/ Item Products ..................................................................................................... 29 

Maintain Costs ........................................................................................................................... 30 

Product Templates..................................................................................................................... 30 

Product Import/Export (PIE) ...................................................................................................... 30 

INVENTORY .................................................................30 

Purchase Orders ........................................................................................................................ 30 

Receiving/Costing ...................................................................................................................... 33 

Special Receiving ....................................................................................................................... 33 

Roll and Item Inventory ............................................................................................................. 34 

Reports....................................................................................................................................... 36 

Utilities ....................................................................................................................................... 39 

Inventory Move ......................................................................................................................... 39 



 

3 
 

ACCOUNTING ..............................................................39 

Dates .......................................................................................................................................... 39 

Accounts Receivable .................................................................................................................. 39 

Accounts Payable ....................................................................................................................... 41 

General Ledger .......................................................................................................................... 44 

Banking ...................................................................................................................................... 45 

Sales Commission ...................................................................................................................... 47 

HUMAN RESOURCES ...................................................47 

Tax Tables .................................................................................................................................. 47 

Sub Accounts ............................................................................................................................. 47 

Prepare Pay ................................................................................................................................ 47 

End of Year ................................................................................................................................. 48 

Reports....................................................................................................................................... 49 

Utilities ....................................................................................................................................... 51 

SALES REPORTS ...........................................................52 

Material Analysis ....................................................................................................................... 52 

Sales ........................................................................................................................................... 53 

Profitability ................................................................................................................................ 53 

Marketing .................................................................................................................................. 54 

SCHEDULE PRO ...........................................................54 

Warnings .................................................................................................................................... 54 

Find Screens ............................................................................................................................... 54 

System Options .......................................................................................................................... 55 

Job History ................................................................................................................................. 55 

Edit Job Screen ........................................................................................................................... 55 

Scheduled Jobs .......................................................................................................................... 56 

Schedule New Jobs .................................................................................................................... 56 

Quick Schedule .......................................................................................................................... 57 

Create Provider Record ............................................................................................................. 57 

Calendar View ............................................................................................................................ 58 

Utilities ....................................................................................................................................... 59 

BIDPRO .......................................................................59 

Interface Mode .......................................................................................................................... 59 

Estimate Lines ............................................................................................................................ 60 

Word Merge .............................................................................................................................. 61 

Print Estimates ........................................................................................................................... 61 

Utilities ....................................................................................................................................... 62 

CLIENT MANAGEMENT (CMM) ....................................62 



 

4 
 

Microsoft Office 365 .................................................................................................................. 62 

System Options .......................................................................................................................... 63 

Templates .................................................................................................................................. 63 

Workbench ................................................................................................................................ 64 

Alerts .......................................................................................................................................... 64 

Sales Leads ................................................................................................................................. 64 

Contacts ..................................................................................................................................... 66 

Projects ...................................................................................................................................... 66 

Utilities ....................................................................................................................................... 68 

E-COMMERCE .............................................................69 

Match Screen ............................................................................................................................. 69 

832 ............................................................................................................................................. 69 

EC Download Selection .............................................................................................................. 69 

COLOR CROSSOVER .....................................................70 

Purchase Orders ........................................................................................................................ 70 

CONTRACT PRICING ....................................................71 

System Options .......................................................................................................................... 71 

Browse Screen ........................................................................................................................... 71 

Contract Lines ............................................................................................................................ 71 

PROPERTY CONNECT ...................................................72 

NHMS .........................................................................72 

Project Overview ....................................................................................................................... 72 

Home Buyer Price Requests ...................................................................................................... 73 

Takeoffs ..................................................................................................................................... 74 

Utilities ....................................................................................................................................... 74 

 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

5 
 

Version 19.0 Update User Guide 
 

This update to the Windows version of the RFMS Business Management System includes many 
new features and enhancements.  The update also includes many "behind the scenes" changes 
that increase processing speed and other performance related functions. This document 
explains only the new features contained in this update.  For all changes, see the release notes 
on the download web page. Click the release notes button to find these.  

 

To see what you may have missed in previous updates, click here.  
 
For directions on loading updates to the RFMS software, click here.  
 
The same documentation is included in the online help system and can be accessed by pressing 
the F1 button at any RFMS screen.  If there is something on the screen that you either don't 
recognize or understand, check this document or refer to the Help Files pressing F1. 
Documentation Conventions  

 
Indicates extra Information  

 
This symbol indicates a best practice or an example. 

Setup>System Setup 
Indicates Menu item shortcuts: An underlined letter indicates this is a “hot 
key.” On Main menus, click the Alt button plus that key to go directly to 
that field or function. On Drop, Down menus type that key.  

Field Name Indicates a Field Name or button Name  

Important  Important information 

Screenshots 
To conserve space the screenshots are seldom actual size and may have 
blank spaces or other non-essential information cropped from them. 

 

Links to other documents or web pages are included when additional 
explanations are available. Click the notebook to find that information.  

Links to other topics 
Various places in this document have links to other topics in the document. 
To return to the original topic, click Alt + left arrow. Try it out with the link 
to the left!    

User-Defined FIELD 

RFMS has many fields that can be user-defined. In the documentation, 
these will be shown in all capitals with the abbreviation UD before the field 

name.   

https://rfmsinc.zendesk.com/hc/en-us/articles/201559487-RFMS-Program-Update-Instruction-Document
https://rfmsinc.zendesk.com/hc/en-us/sections/200359858-Release-Notes
https://rfmsinc.zendesk.com/hc/en-us/sections/200367553-Update-Documents
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Update Release Notes  

Update documents contain only the new features contained the software 
updates. For all changes, see the release notes on the download web page. 

Click the release notes button to find these.    
 

RFMS Button and Menu Conventions 

  
Exit the current screen. Can also use the Escape key on the keyboard. 

 
Access the help file. Can also use the F1 Key on the keyboard. 

 
Activates or selects the highlighted record. 

  
Add a new record. Can also use the Insert key on the keyboard. 

  
Make changes to a record.  

  
Delete a record. 

  
Add or View Notes on a record. 

 
View all notes and Client Management Remarks related to a record. 

  
Find a record using specific fields. Changes to blue when a find is in process. 

  
Resets a filter to the default settings. 

 
Refresh the browse without resetting the filters  

 Saves the current information and exits the screen.  

 
Exits the screen without saving the newly entered information. 

 Exact match required in a search. 

 Partial match only required in a search. 

 or Ctrl-S 

Text search  
Reminder: this searches the browse list from the highlighted record down only. 
When beginning a search, it is best to begin at the top of the list. 

  
Print a document or go to a report menu.  

 
Allows adding, changing, or deleting the graphic, non-graphic files, or web sites.  

http://www.rfms.com/RevisionHistory.aspx
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 Tag Untag Tagall or Un-tagall record(s). Selects records 

 
View details of a record.  

 Send an email or RFMS mail message regarding the highlighted record.  

  
View the history of a record.  

 or  View the pdf history of reports for the highlighted record. 

 or  
Click to view the tracking record created for every record insert made into Orders, 
Quotes, and Bid Pro Estimates. If gray, no records are present. 

 
 

Brings up the Client Management remote actions screen and allows adding a 
CMM action or relate a CMM record to this record. Yellow indicates that CMM 
information is associated with the highlighted record  

 

With all date fields in RFMS, hit the D key to fill in today’s date, type in a date, use 
the up and down arrows to move the date one day at a time or click F8 to bring up 
the calendar and then choose the date. 

 

The bottom part of the screen lists all windows open in the current module. The 
one currently being viewed is checked.  To view a different window, click it with 
the mouse.  

+  
Access to customizing the toolbar 

 
Disabled Field. If set in >Utilities>System Options>System Wide>General > (Set Up 
Global Interface System Options or Override Global Interface System Options) 

 

Required Field. If set in >Utilities>System Options>System Wide>General > (Set Up 
Global Interface System Options or Override Global Interface System Options) 

Edit Menu 

The Edit Menu can be used as a shortcut to the toolbar options.  
>Edit> 
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System-Wide 

PO Integration 
PO Integration being turned off will no longer be the recommended by RFMS starting in 2020.  
If there are issues related to PO Integration being off, then the suggestion to resolve will be to 
turn it on.  

Date Shortcuts  
Click here for more details. 

Ctrl + F=First day of LAST Month 
Ctrl + L= Last day of LAST Month 
A=First day of Current Year 
Z=Last day of Current Year 
Ctrl + A=First day of LAST Year 
Ctrl + Z= Last day of LAST Year 
X=12/25/yyyy (yyyy=current year).  The date will be the next year if the date is after 12/25. 

Users 
Utilities>System Options>Users>Browse Users 
The Copy Browse feature has been added to the User Browse screen. 
 

 

Reports 
Reports that are printed on Legal Size paper will now print on A3 paper.  This is for Australia 
and New Zealand. 

 

https://rfmsinc.zendesk.com/hc/en-us/articles/201877827-Calendar-and-Dates
https://rfmsinc.zendesk.com/hc/en-us/articles/360018852354-Copying-Browse-Information
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Attachment 
The ability to Drag and Drop attachments from Outlook has been added to all Attachment 
screens. 
 

 

 
This feature only works with Local Set Up not with Remote Set Up. 

Export to Order 

The Export to Order button has been changed throughout the program to  for consistency. 

System Options 

Browse Screen 
The Browse screen can now be sorted by columns. 

Copy System Options 
A search box has been added to the Copy To Users side of the Copy System Options browse 
screen. 
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System Option Changes 
Update Quote or BidPro Customer Information if Customer is Edited System Option has been 
removed because of the new Update Customer Data feature. 
 

Order Entry 

Notifications 
Utilities>Setup>Notifications 
This feature gives users the ability to set up different types of notifications in Order Entry, 
Schedule Pro, and BidPro.  The Notification can be sent by email, text, pop-up message, or 
Interoffice Mail in RFMS. It can notify a user or customer about various things such as dates 
approaching, line status changing, orders being created, and much more. 
 

For more details, Click here. 

RFMS Smart Search Fields 
Customer Address Line 2 and Ship-To Address Line 2 has been added to the RFMS Smart Search 
in Quotes, Orders, and Claims. 

Customer Orders, Quotes, and Claims 
Unreferenced Lines 
Unreferenced lines are now displayed in red in Quotes, Orders, and Claims. 
 

 

https://rfmsinc.zendesk.com/hc/en-us/articles/360036639893
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Copy a Line  
The ability to copy a line has been added to the Orders, Quotes, and Claims screen. 

 

 
 
If Exclude Product Info is selected, the line is created with a zero-selling price. 
 

Word Merge 
Line attachments now appear on Word Merge Orders and Quotes. 
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Customer Orders 
Find Screen 
A filter has been added to find orders/claims where Provider Records are Balanced with labor 
on the lines.  Schedule Pro job status has been added to the Find screen.  

 
 

 
Records without Provider Records will not display when the Providers Balanced checkbox is 
checked.   
To Find Cash and Carry orders, filter for Undelivered Only and All Lines Delivered without the 
Providers Balanced checkbox. 

Roll and Item Inventory 
The ability to view Available Inventory by Dye/Run Lot has been added.  This can be viewed by 
clicking the View Dye Lot Information button on the toolbar. 
 

 
 
 
 
 
 
 
 
 
 



 

13 
 

The Inventory By Lot screen will appear with amounts and total. 
 

 

Line Notes 
An Internal Line Note has been added. 
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Product or Warranty Notes 
Product notes and/or Warranty Notes can be seen on the order line.  The Notes button will be 
blue if there is a product or warranty note. 
 

 
To view the notes, the user must be editing the line.  The Product and/or Warranty button will 
be in red. 
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If a line has a product note or a warranty note only, the note icon to the left of the line will be 
white. 
If a line has a Line Internal Note and or a Line Custom Note, the icon to the left of the line will 
be yellow. 
If a line has a  mixture of product, warranty, Internal and Line Custom notes the icon to the left 
of the line will be yellow. 
 

 

Areas  
The Insert/Edit/Delete buttons now can be password protected on the Browse Areas screen. 
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View PO  
The ability to view Freight Carrier and Tracking Number has been added on the View PO screen 
in Order Entry. 
The View PO from Order Line screen will also now include the Buy/Sell Quantity information. 
 

 
 

Print Customer Documents 

Delivery Tickets 
The Vendor Purchase Order Number now prints on the Delivery Ticket 

 
 

Estimated Job Cost 
Estimated Job Cost Parameters on this screen are no longer editable. 



 

17 
 

AIA Billing 
The ability to delete a billing has been added to this screen.  It has a default password setting of 
Level 1.  This was added to allow a job with AIA Billing to be un-job costed. 
 

          
 
The ability to split AIA Billing lines has been added.   

 

 
• Splitting AIA Billing Order Lines is only available for the "Select Order Lines" method. 

• Only Primary AIA Billing Lines can be Split. 

• Split off amount cannot be edited and must be fully billed in the billing the split was 

done.  If it is not tagged when Creating the AIA Billing, the split line details will not be 

saved and will have no effect on future AIA Billings. 
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• If a primary AIA Billing Order Line is split, the Description of Work for the primary line 

can no longer be edited. 

• If a primary AIA Billing Order Line Description of Work has been edited, it cannot be 

split. 

• The split AIA Billing Order Line Description of Work cannot be the same as the primary 

AIA Billing Order Line. 

• If a primary AIA Billing Order Line is split more than once, each split line must have a 

different Description of Work. 

• Split AIA Billing Order Lines will have an incremental split number that can be seen in 

the AIA Line Type column.  Also, the split icon will be displayed in the Description of 

Work column. 

• The primary AIA Billing Order Line will be reduced by the amount split off in the current 

AIA Billing and all future AIA Billings. 

 

Quotes 
Quotes printed using Subtotal by Group Number will now sort by line numbers.                                                                         
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Find Screen 
The ability to have a Static List has been added to the Quotes Find screen. 
 

 
 

Claims 
The ability to add providers and view receipts while editing a claim has been added. 
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Batch Processing 
Work Orders 
The ability to collate on the Confirm Work Order screen has been added. 

 

 

Customers 
Adding Customers 
The ability to edit the Sales Reps will now be unlocked by default when adding a customer. 
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Tax Certificates 
A tab has been created on the Customer Record to add, edit, or delete tax certificates for a 
customer. 

 

 
 

 
When creating an order, the correct Tax Certificate is selected for the user but can be 
overridden if needed.  
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If only one Tax certificate is on the customer record, the one automatically comes in when 
adding new orders to billing groups.   
If there are multiple tax certificates on the customer record, a picklist will appear after entering 
the customer name.  The certificates are listed in the following order None, Ship To, and 
Customer record. 
The only certificates that will come over are the Active/Current ones. 
 

 

Click F8 beside Certificate Type to Select, Insert, Edit, Delete a Certificate Type. 

 

The Tax Certificate tab has also been added to the Additional Shipping Addresses screen in the 
Customer Record.  A Tax Certificate can be pull from the Additional Ship To addresses even if a 
certificate was pulled from the Sold To. 
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If there is an attachment on the Tax Certificate, then the attachment icon will appear on the 
line. 

 

Expired Certificates will be shown in red. 

 

Find Screen 
The ability to filter by Customers, Prospects, or All has been added to the Customer Find screen. 
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Mailing Labels 
If a record that is tagged to be printed does not contain certain info, the user is now notified of 
which customers and what information is missing. 
 
Labels will not print unless all tagged records have all the necessary information. 
 

 

Update Customer Data  
Customer Data can now be updated in a group by using the Update Customer screen.  Updates 
can be made to Quotes, BidPro Estimates, and Customer Information. 
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Tag the Customer(s) that need to be updated and click the Update Customer Data button  . 
Next, make selections from the area needing updating.  On the Quotes and BidPro Estimates 
tab, the records can be previewed before making the change by clicking Load and Preview. 

 

Click Update button after checking the information.  As the warning states, this change is not 
reversible.  Click Yes if this is the changes that need to be made. 
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A message will appear listing how many updates were made. 

 

 

If a change is made to the Customer Record from this screen and then the change needs to be 
made on Quotes or Estimates, the screen must be exited and reentered to be able to make that 
change. 

If “Sold To Address” and “Ship To Name & Address” are checked under Select Fields to Update, 
this routine will update the information regardless of the Sold To being locked or Allow Edit of 
Ship To being set to No. 

Reports 
Provider Earnings 
Order Entry>Reports>Provides Earnings 
The ability to search for a single provider by using F8 has been added.  Only providers that have 
unpaid records will be seen in the dropdown.  If the field is left blank, it will include all 
Providers. 
 
Suppliers can be selected by clicking the S button. 
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Provider’s Earnings History 
Reports>Provider’s Earnings History 
 

The ability to search for a single provider by using F8 has been added.  If the field is left blank, it 
will include all Providers. 
 
Suppliers can be selected by clicking the S button. 
 

 
 
A checkbox has been added to include or exclude records posted from AP. 
Checking this box will exclude records from that report that came from the Black Arrow in AP. 
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Export Financial Progress Data to CSV 
Reports>Export Financial Progress Data to CSV 
A checkbox for “Include Delivered Orders with Outstanding Balances” has been added to the 
screen.  This allows the user to determine if delivered orders with an outstanding balance will 
be treated as open order and included in the report. 
 

 
 

Utilities 
Setup 
All the options under Setup have been reorganized to make the selection more convenient. 

Cities 
Utilities>Setup>Cities 
The ability to adjust the tax rate by city and county has been added to the Adjust Rates screen. 
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The ability to add attachments to a city have been added to the City Information screen. 
 

 

Products 

General 
The ability to merge products to or from an EC Product has been removed as much of the 
information on EC Products. 

 

Roll Products/ Item Products 

View Only Tagged Records  
The View Only Tagged Records button has been added to the Roll Products toolbar.  If clicked, it 
will display only the tagged records. 
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Maintain Products 
Utilities>Maintain Products 
Color deactiviation has been removed from this routine.  Colors must be removed manually by 
running Apply Deactivation for colors. 

Maintain Costs 
Utilities>Maintain Costs 
Maintain Costs has been added to the Utilities screen.  This feature can remove old records 
from the Prodcost file based on a given date. 

 

Product Templates 
Utilities>Product Templates 
The Roll Default Quantity has been removed from the Product Template Information screen. 

Product Import/Export (PIE) 
Utilities>Product Import/Export (PIE) 
The amount of characters allowed in the Import File Name has been increased. 

Inventory 

Purchase Orders 
Stock Purchase Orders for ALL Products except EC will print the Store Ship To address.   If the 
Store Code does not have a Ship To address or an Additional Ship To address set up, then the 
Store Address will be used. 
EC PO Printing will print the Ship To from EC ship file unless a Ship To has been entered.   
 
The Add/View/Edit Ship To button will be red if the Purchase Order is an EC Purchase Order.  It 
now turns red because it is populated with the hard-coded information from EC. 
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The Reference Number field has been added to RFMS Smart Search. 
 

 
 
If the product code is changed from Roll to Items when inserting a new purchase order, the unit 
of measure is blanked out. 
 
A Work Order Areas button has been added to the Add/Edit Purchase Orders screen. 
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When editing a Purchase Order, The Tiered Cost button text will be in red if there is a Tiered 
Cost associated with the product. 
 

 
 

Change Info on All Lines of the Selected PO  
Change PO Lines where Status = To Be Ordered has been added as an option on the Changing 
PO screen.  This gives the user the ability to only change the line in the Purchase Order that is in 
the To Be Ordered Status. 
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Auto PO 
If an attachment has been added to an order line, it is now viewable on the Auto PO screen. 
 
Invoice Number and Line Number are now indicated on Error Messages received when 
generating an Auto PO. 
 

 
 

Receiving/Costing 
CTRL + T will move down to the next line when tagging during Receiving also. 

Special Receiving 
E-Commerce ASN Receiving 
File>Special Receiving>E-Commerce ASN Receiving 
The ability to Receive ASNs from the Inventory module has been added to the Special Receiving 
area. 
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Roll and Item Inventory 
The On Order Date has been added to the browse screens. 
 

 
 

Load 
The lock button will be locked as a default, and the ability to set a password on the lock button 
has been added. 
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Roll Core Tags 
Starting printing position can now be chosen for the Roll Core Tags. 
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Reports 
PO Reference Number Added to Reports 
Reports>Roll Inventory Range Report or Item Inventory Range Report 
The PO Ref Number has been added to the CSV for Roll Range Report, Item Inventory Range 
Report, Roll Inventory Information Report, and Item Inventory Information Report. 

      
Roll Range Inventory Report                                    Item Inventory Range Report 

     
Roll Inventory Information Report                         Item Inventory Information Report 

 

Needed Inventory Report 
The PO Number has been added to the report and the CSV. 
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Item History Report 
Reports>Item History Report 
New-On Order and Sold-On Order have been added as Statuses. 
 

 
 
 
 
 
 

Inventory Adjustments Report 
Reports>Inventory Adjustments Report 
A Print Preview option has been added. 
 

 
 

Roll Inventory Physical Report and Item Inventory Physical Report 
Reports>Roll Inventory Physical Report or Item Inventory Physical Report 
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The PO Number has been added to the Roll and Item Inventory Physical Report. 
 

 
 

    
 

Stock Status Report 
Reports>Stock Status Report 
GenPO has been added as a status in the Sold (From Lines) section of the report. 
 

 
 
 



 

39 
 

Utilities 
Item Inventory Consolidation Tool 
Utilities>Item Inventory Consolidation Tool 
Run Lot has been added to the Item Inventory Consolidation Browse Screen. 

 
Consolidate Item Inventory screen now displays 4 decimals for cost.  A PO Number column and 
a Freight column have been added. 
 

 
 

Inventory Move 
Requested Inventory Screen 
If there is an Inventory record that no longer meets the requested criteria, then the requested 
flag on the line will be released, and it will return to a regular reserve. 
 

Accounting 

Dates 
If J is pressed while in a date field in the Accounting module, the last Journal Closed date will be 
populated in that field. 

Accounts Receivable 
Statements 

Print Statements 
Files>Accounts Receivable>Statements>Print Statements 
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If selected from the Statements print screen, the Order Due Date will now print on Statements. 

 

 
 

Mult-Pay 
File>Accounts Receivable>Multiple Payments 
The Skip Check Number button on the Check Number message screen can now be password 
protected. 
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Last Payment/High Credit 
File>Accounts Receivable>Last Payment/High Credit 
A discount is now marked as a discount instead of a payment. 
 

 
 
 
 

Accounts Payable 
The AP Detail Comment has been increased to 75 characters. 
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Suppliers 
The Payee field has been increased to 80 characters. 
 
When Inactive Suppliers are included, they are now grayed out on this screen. 
 

 

A/P Reports 

A/P Paid by Account Code or Check 
The ability to print the report in order by Paid Online has been added. 
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A/P Invoice Listing Report 
File>Accounts Payable>A/P Reports>A/P Invoice Listing. 
A Combine Stores checkbox has been added to the AP Invoice Listing Report. 
 
Break on Invoice is now Subtotal by Invoice. 
 

 
 
 
A/P Invoice Listing Report now shows the subtotal for each store. 
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AP Aging 
The Due Date field has been added to the CSV file. 

 
 

General Ledger 
The comment field in the Journal has been increased to 75 characters. 

Chart of Accounts 
File>General Ledger>Chart of Accounts 
The columns size in the Chart of Accounts browse screen is now adjustable. 
 
 
 
 
 
 
 

Journal Batch Entries 
File>General Ledger>Journal Batch Entries 
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The Transaction Date defaults to blank and is now required. 
 

 
 
If a reversal date is entered, then the reverse checkbox is checked by default for each 
transaction when it is being added. 
 

 
 
 

Banking 
Reconcile Register 
File>Banking>Reconcile Register 
The ability to add a bank charge during reconciliation has been added. 
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Show Bank Balances 
File>Banking>Show Bank Balances 
The Show Bank Balances screen is now a re-sizable window. 
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Sales Commission 
Store Code and Customer Type 
Store Code and Customer Type have been added to the CSV for Print Commissions, Print and 
Post Commissions, and Print Commission History. 

 
Print Commissions and Print and Post Commissions                                                Print Commission History 

Human Resources 

Tax Tables 
The Tax Table for Idaho, Minnesota, and Virginia has been updated with the 2019 values. 

Sub Accounts 
The ability to F8 to pull in Subaccount codes has been added to the Percentage Tax Rate screen, 
the Pay Preparation screen, and Personal Deductions screen. 

Prepare Pay 
Salary Hours 
A Salary Hours field has been added to the Prepare Pay screen so that Salary Employee Hours 
can be tracked. 
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Check Stubs 
Overtime and Doubletime Hourly Rates have been added to the Check Stub for Hourly 
Employees. 

 
 
 

End of Year 
Generate W-2 & 1099 Information 
Human Resources>File>End of Year>Generate W-2 & 1099 Information 
The ability to filter 1099s that are less than the given threshold for a year has been added to the 
Generate screen. 
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Reports 
Compensation Report 
Total Gross and Medicare Taxable have been added as Gross to Use options on the Worker’s 
Compensation Report screen. 
 

 

Quarterly Reports 

941 Quarterly Report Printed 
Human Resources>Reports>Quarterly>Reports>941 Quarterly Report Printed 
The ability to select Do Not Print, Print Full, or Print Mask for Print SS Number is now available 
on this report screen. 
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Paid Family Medical Leave 
 
Human Resources>Reports>Quarterly>Reports>Paid Family Medical Leave 
The ability to print a report or create a CSV file for Family Medical Leave has been added. 
 

 
 

Re-Print Pay Stubs 
Reports>Re-Print Pay Stub 
From this new feature, users can search for a check from the Pay History to find a check stub 
that needs to be printed. 
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Utilities 
Format Payroll Check 
Utilities>Format Payroll Check 
The company name can now be printed on the Payroll Check. 
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Sales Reports 

Material Analysis 
Quotes 
The ability to Save and Load a filter has been added to the Quote Material Analysis. 
 

 
 

https://rfmsinc.zendesk.com/hc/en-us/articles/217967458-Saving-and-Loading-Filters-on-Find-Screens-and-Reports
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Sales 
Sales Totals 
File>Sales>Sales Totals 
The ability to print and filter by Customer Type has been added. 
 

 

Profitability 
Job Cost Analysis Report 
File>Profitability>Job Cost Analysis Report 
The Ship-To City, State, and Zip have been added to the CSV. 
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Marketing 
Top Sellers 
The ability to Save and Load a filter has been added to the Top Sellers Report. 

 
 
 

Schedule Pro 

Warnings 
Schedule Pro Warnings now include the line number on the line with the issue. 
 

 
 

Find Screens 
Enter can now be used as a hotkey for the OK button. 

https://rfmsinc.zendesk.com/hc/en-us/articles/217967458-Saving-and-Loading-Filters-on-Find-Screens-and-Reports
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System Options 
System Options 
The System Option Create Provider Records for Service Lines with No Crew Scheduled has been 
removed.  Schedule Pro no longer creates Provider Records with no Crew assigned.   
To compensate for this, the ability to edit a job and add a provider has been added to the 
Create Provider Records screen.  There is also the existing ability to assign a provider and create 
the provider record from the Quick Edit Screen. 

Job History  

A Job History button  has been added to the Scheduled Jobs, Edit Jobs, and Quick Schedule 
toolbar.  Job History automatically adds a record when there are any changes to the job.  It 
tracks changes made by Edit Job, Weekly Grid, Quick Edit, and Quick Schedule.  It gives more 
details when Primary Crew, Secondary Crew, or Scheduled/Actual Start and End Dates are 
changed. 
 

 

Edit Job Screen 
The Labor Total display field has been added to the Edit Job screen. 

 



 

56 
 

Scheduled Jobs 
Location has been added to the Scheduled Job Lines Browse screen (bottom screen) on the 
Scheduled Job screen. 

 
 

Schedule New Jobs 
A Worker ID column has been added to the Select Crew to Schedule screen. 
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Quick Schedule 
The Copy Browse function (Ctrl + Alt + Shift + C) has been added to the Quick Schedule Browse 
screen. 
 
Work Orders will print for tagged jobs in the order of crew names. 

Create Provider Record 
The ability to edit the highlighted job on the Create Provider Records Browse screen has been 
added. 
The Edit Override Rate button is now in line with the other related buttons. 

 
 

Provider Rate has been added as a column to the Create Provider Record Browse screen. 
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The Worker Id will display on the Create Provider Records browse.   

 

Calendar View 
Open Schedule Pro in Read Only 
When this System Option was set to yes, some of the text on the Calendar View still appeared 
yellow and was hard to read.  This has been changed to blue. 
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Utilities 
Setup 

Crews 
The Worker Id now displays on the Crew Set Up Browse. 

 

BidPro 

Interface Mode 
Model is now included in interface mode and no longer a required field. 

The Job # field, Ad Source, Order Type, Contract Type, Service Offering, Customer Email, and 
Area in BidPro have been added to the Interface Mode. 
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Estimate Lines 
When adding/editing a line, only the line that was added or editing will be calculated at the line 
level. 
 
The line number can now be edited to an existing line number.  The current line number will be 
moved down as will the ones below it. 
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Word Merge 
Word Merge now pulls over Line Attachments. 

 

Print Estimates 
Load and Save 
The ability to load and save settings has been added to the Printing Estimates screen. 
 

 

Save To PDF History 
Save to PDF History has been added to the Print Estimates screen. 
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Utilities 
Purge Estimates 
The ability to include or excluded templates and exported estimates in the purge has been 
added to the Purges Estimates screen. 

 

Client Management (CMM) 

Microsoft Office 365 
The ability to use Microsoft Office 365 for Outlook Integration has been added to RFMS.  This 
will allow users with Microsoft Office 365 to integrate with Client Management (CMM) for tasks 
and appointments. 

To set this up, Microsoft Office 365 needs to be selected in the Synchronize User with Outlook 
System Option. 

 
 

https://rfmsinc.zendesk.com/hc/en-us/articles/201556277
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Once Microsoft Local Outlook File or Microsoft Office 365 is selected, then the options for 
Automate Integration will be able to be chosen. 
 

 
When using Microsoft Office 365, F5 must be used to refresh the page when any changes are 
made. 

System Options 
The System Option Telephone 1 Required in Orders, Quotes, or Claims  is now available for 
CMM.  If the option is set to yes, the Telephone 1 field must be filled in when creating an order 
or a quote from CMM. 
 

Templates 
The ability to filter by Templates Only has been added to the Tasks, Appointments, Remarks, 
and Alert browses. 
 

 

 

 

 

 

https://rfmsinc.zendesk.com/hc/en-us/articles/360006090713
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Workbench 
The Customer’s name has been added to Order Line Status Change Alerts in the Alerts section 
of the Workbench. 

 

Alerts 
The ability to filter by Alert Type has been added to the Alerts browse screen. 

 
 

Sales Leads 
The ability to filter Sales Leads by location has been added to the Sales Lead Browse screen. 
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Potential Sales column has been added to the Sales Lead Browse screen. 

 

The Notes feature has been added to the add/edit Sales Lead screen.  This should be used 
instead of a remark if a longer comment is needed.  Remarks are limited to 500 characters as 
they can print on certain reports. 
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Contacts 
The ability to add an attachment to a contact has been added. 
 

 

Projects 
An Attachment button has been added to the Project browse screen. 
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Project Profile 
An F8 button has been added beside the City on the Project Profile tab. 

 
 

Orders 
The ability to view lines on an order in a Billing Group has been added. 

 

Purchase Orders 
The ability to sort using the columns has been added to the Purchase Order tab. 
 
 
 
 
 
 
 

https://rfmsinc.zendesk.com/hc/en-us/articles/204113826-Sorting-in-the-Browse-Screen
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Sidemark has been added to the Purchase Order tab. 

 
 
The Comments field has been added on the Purchase Order tab. 

 
 
 

Utilities 
Utilities>View User Statuses 
A search field has been added to this screen. 
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Email Templates 
Utilities>Client Management Set Up>Email Templates 
A checkbox has been added to filter by the templates created by the current user only. 

 

E-Commerce 

Match Screen 
The Carton Qty has been added to the match pop up screen. 

832 
The Store Code has been added to the Supplier Cross Reference table for 832 mapping import. 
If using Store Specific, the user can add mapping at the store level. When importing, all prior 
mapped stores will still work until updated to Store Specific. 

EC Download Selection 
Pre-Import Matching Report is no longer available.  The Post-Import Report should be used. 
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Items (19.0.2) 
Items length and width will populate following the rules below: 

Insert - the Actual Length and Width will be populated if data available 
Update - the Actual Length and Width will be populated if data available and the product record 
has no data in those fields 
 

Color Crossover 

Purchase Orders 
If a system is not set to use Color Crossover, then the Color Crossover button will not appear on 
the Purchase Order Edit screen or the Auto PO toolbar.   
If the system is set to use Color Crossover, then the button will appear, and if the product has a 
cross over, then the button will be enabled.  When there is no cross over, the button will not be 
enabled. 
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Contract Pricing 

System Options 
Cost to Use System Option is now Global and locked. 
 

Browse Screen 
The Browse Contracts screen can now be sorted by the Main and Branch columns. 
 

 

Contract Lines 
Unreferenced lines are now marked in Red on the Contract Lines screen. 
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Property Connect 

 
Properties not published to the Web will no longer appear in the Admin Property Assignment 
List. 

NHMS 

Project Overview 
Option Takeoffs 
Project Overview>Pricing Versions>Options>Option Takeoffs 
The ability to Copy Standard Option Categories to Multiple Records has been added to the 
Takeoffs screen. 
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Standard Special Charges 
Project Overview>Pricing Versions>Flooring>Standard Special Charges 
The ability to copy the highlighted line to the tagged line has been added. 
 

 
 
 
 
 
 
 

Upgrade Special Charges 
Project Overview>Pricing Versions>Flooring>Upgrade Special Charges 
The ability to copy the highlighted line to the tagged line has been added. 
 

 
 

Home Buyer Price Requests 
An F8 button has been added beside Quantity on this screen to pull in Takeoffs. 
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Takeoffs 
Columns for Sizes and Units have been added to the Takeoffs Browse Screens. 

 

 

 

 

 

 

 

Utilities 
Add Products 
Utilities>Add Products 
The ability to select a blank group has been added to the Group dropdown menu. 
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Update Products 
Utilities>Update Products 
Update Products is no longer one screen with tabs.  Each tab has its own screen and is selected 
from the menu under Utilities. 

 

Select Project Version to Update 
The Find screen for Select Project Version to Update area includes Stage, Project Overview.  It 
also gives the user the ability to hide Completed Projects. 
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Select Specifications to Update 
On the Flooring and Options screen in the Select Specifications to Update area, the Find screen 
can now be filtered by Product fields, PC, Store, Category, and Group.  The filter can also be 
saved and loaded. 
 

 
 
 
Cost Column and a Color Browse have been added to this area. 
 

https://rfmsinc.zendesk.com/hc/en-us/articles/217967458-Saving-and-Loading-Filters-on-Find-Screens-and-Reports


 

77 
 

 

Update Specs 
This button is now included on the Update Products screen for each of the three menu options. 
This screen includes checkboxes to select the fields to update and which settings will be 
updated. 
 

 
 
The ability to globally update Special Charges has been added to this screen. 
 
 
 
 
 
 
 
 

Update Cost 
This screen allows the user to choose what the updated cost will be based on and how the cost 
is to be recalculated.  Update Specification Labor Cost and Update Category Default Costs are 
also included on this screen. 
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Update Installations 
This screen gives the user the ability to update Gross Profit, Total, and Use for Alternate 
Installations.  This screen also includes Group and Automatically Set Installations Offered.   

 
 

 
The Update Installations button will be grayed out if Update All Products in Tagged Versions is 
checked. 

This screen is not available for Trim and Underlayment Products. 
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For flooring, Alternative Installation is only available for Options 1-4. 

 

Gateway (19.0.2) 

Items 
Items will insert/update the length and width by following the rules below: 

Insert - the Actual Length and Width will be populated if data available 
Update - the Actual Length and Width will be populated if data available and the product record 
has no data in those fields 
 


